BISD Technology Curriculum
Grade 4

Vocabulary
Title Bar
Graphic

File extension
Download
Presentation
Netiquette
Virus
Navigate
Multimedia

Field
Search
Hyperlink

Foundations;

Use My Computer to navigate to available drives, 2C

Open and close programs using method of choice. 1B

¢ Use mouse to perform single-click, double-click, and click and drag functions with the
left and right mouse buttons. 2A

= Use the mouse to scroll up or down within a window by clicking and dragging the scroll
bar or clicking the up or down arrows. 2A

4: Minimize, maximize, and restore windows as needed. 2A

Work with more than one window open. 1B

% Open CD-ROM tray, insert CD, close CD-ROM tray, and access files/programs on CD.

2A

“+ Understand and properly use Save and Save As.1B

Use the Unde feature in Microsoft Office applications to recover previous work. 2D

Take pictures using a digital camera and upload them to a computer. 2A

Take videos using a digital video recorder and upload video to computer.

Print documents. 1E

4 Use the scanner to digitize images and use them within an application. 24, 7C




# Navigate through appropriate programs. 2AUse Copy, Cut, and Paste functions to edit
documents. 2D, 7B, 7C
Use the Help menu to type in a keyword and/or look at the available list of topics. 9A
Use the Print Preview, Slideshow/View Show, and Slide

Sorter View features available in programs to view files for proper

format prior to printing. 9B

Netwurklng

* Create, name, and save files to a drive on the network. 1B

Access files from the network folder. 1E

Print to a networked printer using the printer icon or selecting Print from the File

menu. 1E

# Select and print to the appropriate networked printer. 1E

Save files from the network folder by copying (by clicking and dragging the icon) or

using the Save As feature within the program.1B

Acceptable Use:

Knows not to use other’s work. 3B

Knows it is inappropriate to access another individual’s file. 3B

%2 Knows it is not appropriate to copy/load software for which you do not have a license.
3B

% Student will demonstrate an understanding of the rules when accessing BISD
computers. 3A

Information Acquisition:

# Acquire information that is in the form of text, graphics, audio, and video and save
mformation for use in student projects in accordance with copyright issues, with teacher
assistance, as needed. 5A, 4A, 4B
# Analyze the content and validate the accuracy of the information acqmred from the
Internet. 6A, 6B, 6C

rﬂblem Solving:

s Use software to express ideas and solve problems. This can include, but is not limited to
text, graphics, charts, and visual organizers, multimedia and spreadsheets 74, 78, 7C,
10C

# Use communication tools to acquire and share information and solve problems (e.g.

distance learnmg, email). 8A, 8B, 8C

Participate in electronic communities. 8C

Soﬁware Applications:

Word Processing (Microsoft Word):

% Create a new document or open an existing one on the network folder. 2D, 2E

Enter text. 2C, 2D

Apply Word Art. 10A,B

Change font size, type, style and color of font. 10A, 10B

Use Alignment tools to format text 104, 10B

Format text by using Bullets and Numbering. 104, 10B

Use the Backspace and Delete key to delete text. 2D

Use the Shift key to make capital letters and access punctuation marks. 2C, 2D

Uses Spell Check and Thesaurus. 2D, 10AB

% Insert pictures from Clipart Gallery and from File. 24, 10A

zV




% Move and resize clipart and or images by right-clicking on the image, selecting Format
Picture, clicking the Layout tab, and choosing the appropriate Wrapping Style or
using the Picture Toolbar. 7A, 10A

Multimedia/ PowerPoint:

i

%+ (Create a new presentation or open an existing presentation on the network folder. 7A,
7B, 1K, 11A,B

% Use a teacher-created template to complete an activity. 7A, 7B

Knows difference between ‘edit mode’ and ‘show mode’. 9B

Add transitions and sounds to objects and slides. 9A

Imports video and sound. 10A, 7A,C

¢ Applies good design principles. 10B

¢ Uses draw tools to create objects. 10A

Add text to slides. 114, 11B

Insert multiple New Slides. 7A, 7B

i Change font size, type, style (bold, italicize, underline), and color. 104, 10B

¢ Use Alignment tools to format text (left, right, center, justify). 10A, 10B

Format text by using Bullets and Numbering. 10A, 10B

Insert pictures from Clipart Gallery and from File (e.g. My Pictures, network folder,

digital camera, scanner, or other source). 24, 10A

% Insert video from File. 24, 10A

% Change backgrounds by selecting Format from the menu bar and choosing
Background. 104, 10B

# Use the Slide Sorter view to organize {(change sequence} and edit presentation. 9A,
9B

Spreadsheet (Excel):

# QOpen and existing spreadsheet on the network folder. 1E, 10C

¢+ Enter data in an existing template to complete an activity 7B, 10C

Identify and locate cells, rows, and columns. 7B, 7C

 Create a spreadsheet by entering text, and values (numeric). 78, 10C

 Use Chart Wizard to create charts/graphs as grade level and task appropriate to

express ideas and solve problems. 7B, 10C

4 Change the font size, type, style (bold, italicize, underline), and color. 104, 10B

Desktop Publishing

+ Use a teacher-created template to complete an activity. 1E, 74, 7C

¢ Click in the text boxes and replace text. 2D

# Insert pictures from Clipart Gallery and from File (e.g. My Pictures, network folder,

digital camera, scanner, or other source). 2A, 10A

Internet Browser (Internet Explorer):

# Click on a link to view a web site. 5A

“ Use the Back, Forward, and Home buttons to navigate. 54, 5B

% Conduct simple keyword searches using a grade-level appropriate search engine. 4A, 4B,
5A

# Gather information from the websites found from search results. 54, 58

¢ Evaluate the effectiveness of search strategies. 6A, 6B

¢ Determine whether web sites provide useful and appropriate information. 6C

« Use the acquired information in the creation of products. 11A




# Use the web to tour virtual environments, remote locations, and/or explore on line
interactive lessons. 8B

Communication:

# Designs, develops and publishes real-world produects for a variety of audiences in a
variety of forms (print, monitor, projector, and video). 10B

i Properly sites all information sources. 3B

Use desktop publishing techniques to create effective documents and presentations

(make good choices with regard to font, white space, and contrast for readability). 10A

% Create charts/graphs using spreadsheets/databases and extract information from them.
10C

* Proofread products and make improvements. 2D, 2E

% Select representative products to be collected and stored in an electronic portfolio with
teacher assistance. 12A

¢ Evaluate products created for relevance to the assignment or task. 12A

Create tools such as checklists or timelines to evaluate the progress of a project.




BISD TECH CURRICULUM
GRADE 5

Vocabulary
Peripherals
Html
Byte
Kilobyte
Megabyte
Gigabyte
WAN
LAN
Ethernet cable
Modem
Simulations
Operating systems

Foundations;

Use My Computer to navigate to available drives. 2C
Open and close programs using method of choice. 1B
% Use mouse to perform single-click, double-click, and click and drag
functions with the left and right mouse buttons. 2A
4 Use the mouse to scroll up or down within a window by clicking and
dragging the scroll bar or clicking the up or down arrows. 2A
Minimize, maximize, and restore windows as needed. 2A
Work with more than one window open. 1B
# Open CD-ROM tray, insert CD, close CD-ROM tray, and access files/programs on CD.
2A
“ Understand and properly use Save and Save As appropriately.1B
Use the Undo feature in Microsoft Office applications to recover previous work .2D
Take pictures using a digital camera and upload them to a computer. 2A
Take videos using a digital video recorder and upload video to computer.
Print documents. 1E

% Use the scanner to digitize images and use them within an application. 24, 7C




% Navigate through appropriate programs. 2AUse Copy, Cut, and Paste functions to edit

documents, 2D, 7B, 7C

Use the Help menu to type in a keyword and/or look at the available list of topics. gA

# Make informed decisions in choosing appropriate technology systems, resources, and

services. 7B, C, 10C
% Use the Print Preview, Slideshow/View Show, and Slide
Sorter View features available in programs to view files for proper format prior to
printing. 9B

Networking:

% Create, name, and save files to a drive on the network. 1B

Access files from the network folder. 1E

¢ Print to a networked printer using the printer icon or selecting Print from the File

menu. 1E

Select and print to the appropriate networked printer. 1E

¢ Save files from the network folder by copying (by clicking and dragging the icon) or

using the Save As feature within the program.iB

Acceptable Use:

# Knows not to use other’s worlk, 3B

Knows it is inappropriate to access another individual’s file. 3B

& Knows it is not appropriate to copy/load software for which you do not have a license.
3B

% Student will demonstrate an understanding of the rules when accessing BISD

computers. 3A

Information Acquisition:

% Acquire information that is in the form of text, graphics, audio, and video and save
information for use in student projects in accordance with copyright issues, with teacher
assistance, as needed. 5A, 4A, 4B

% Analyze the content and validate the accuracy of the information aquired from the
Internet. 64, 6B, 6C

Problem Solving:

#¢ Use software to express ideas and solve problems. This can include, but is not limited to
text, graphics, charts, and visual organizers, multimedia and spreadsheets. 7A, 7B, 7C,
10C

# Use communication tools to acquire and share information and solve problems (e.g.
distance learning, email). 84, 8B, 8C

# Participate in electronic communities. 8C

Software Applications:

Word Processing (Microsaft Word):

Create a new document or open an existing one on the network folder. 2D, 2F
Enter text. 2C, 2D

Apply Word Art. 10A,B

Change font size, type, style and eolor of font. 104, 10B

Use Alignment tools to format text 104, 108

Format text by using Bullets and Numbsering. 10A, 10B

Use the Backspace and Delete key to delete text. 2D

Use the Shift key to make capital letters and access punctuation marks. 2C, 2D
% Uses Spell Check and Thesaurus, 2D, 10AB




# Sets margins and tabs. 10AB
¢ Insert pictures from Clipart Gallery and from File. 24, 10A
4 Move and resize clipart and or images by right-clicking on the image, selecting Format
Picture, clicking the Layout tab, and choosing the appropriate Wrapping Style or
using the Picture Toolbar. 7A, 10A
Multimedia/ PowerPoini:
% Create a new presentation or open an existing presentation on the network folder. 74,
7B, 1E, 11A,B
#: Use a teacher-created template to complete an activity. 7A, 7B
: Applies backgrounds to slides. 16A,B
- Apply Word Art. 10A,B
+ Knows difference between ‘edit mode’ and ‘show mode’. 9B
* Add transitions and sounds to objects and slides. gA
¢ Imports video and sound. 104, 7A,C
- Applies good design principles. 10B
* Uses draw tools to create objects. 10A
- Add text to slides. 11A, 11B
= Insert multiple New Slides. 7A, 7B
- Correctly apply hyperlinks to text or objects. 10B
- Change font size, type, style (bold, italicize, underline), and color. 104, 10B
- Use Alignment tools to format text (left, right, center, justify). 104, 168
¢ Format text by using Bullets and Numbering. 10A, 10B
& Insert pictures from Clipart Gallery and from File (e.g. My Pictures, network folder,
digital camera, scanner, or other source). 2A, 1A
4 Insert video from File. 24, 1A
% Change backgrounds by selecting Format from the menu bar and choosing
Background or using the right-click menu. 104, 10B
%+ Use the Slide Sorter view to organize (change sequence) and edit presentation. 9A,
9B
Spreadsheet (Excel):
% Open and existing spreadsheet on the network folder. 1E, 10C
Enter data in an existing template to complete an activity 7B, 10C
- Identify and locate cells, rows, and columns, 78, 7C
+ Create a spreadsheet by entering text, and values (numeric). 7B, 10C
% Use Chart Wizard to create charts/graphs as grade level and task appropriate to
express ideas and solve problems. 7B, 10C
% Change the font size, type, style (bold, italicize, underline), and color. 104, 10B
Desktop Publishing
% Use a teacher-created template to complete an activity. 1E, 7A, 7C
~ Click in the text boxes and replace text. 2D
- Insert pictures from Clipart Gallery and from File (e.g. My Pictures, network folder,
digital camera, scanner, or other source). 2A, 10A
Internet Browser (Intemet Explorer):
- Click on a link to view a web site. 5A
Use the Back, Forward, and Home buttons to navigate. 54, 5B
% Conduct simple keyword searches using a grade-level appropriate search engine. 4A, 4B,
5A
#  Gather information from the websites found from search results. 54, 5B




+ Evaluate the effectiveness of search strategies. 6A, 6B

- Determine whether web sites provide useful and appropriate information. 6C

- Use the acquired information in the creation of products. 11A

- Use the web to tour virtual environments, remote locations, and/or explore on line
interactive lessons. 8B

Commumcatmn'

4+ Designs, develops and publishes real-world products for a variety of audiences in a

variety of forms (print, monitor, projector, and video). 10B

Properly sites all information sources. 3B

Use desktop publishing techniques to create effective documents and presentations

(make good choices with regard to font, white space, and contrast for readability). 10A

% Create charts/graphs using spreadsheets/databases and extract information from them.

10C

Proofread products and make improvements. 2D, 21

Select representative products to be collected and stored in an electronic portfolio with

teacher assistance. 12A

Evaluate products created for relevance to the assignment or task. 12A

Create tools such as checklists or timelines to evaluate the progress of a project.




